
 

  

PathoProof Complete-16 kit 
INSTRUCTIONS OF USE 
 

Catalog Numbers PF1650/PF1600 

Publication Number D14910  

Revision 3 

  

  



 

 

Revision history:  

Revision Date Description 

3 8.1.2018 
New manual layout design. Added Applied Biosystem QuantStudio 5 support. Included 
example picture to dilute samples in manual Large kit extraction. Updated kit component 
information. Updated ordering information for PCR consumables. Minor text changes. 

 



 www.thermoscientific.com/contactus 

Contents 

1. Introduction ............................................................................................................ 1 

2. Kit components and storage conditions .................................................................. 2 

2.1 KingFisher kit ................................................................................................................................ 2 

2.2 Manual Large kit ............................................................................................................................ 3 

2.3 Manual Small kit ............................................................................................................................ 4 

2.4 Real-time PCR reagent description .............................................................................................. 5 

3. Materials required but not supplied ........................................................................ 6 

4. General guidelines ................................................................................................. 7 

4.1 Avoiding carryover contamination ................................................................................................. 7 

5. PathoProof Assay Workflow ................................................................................... 8 

5.1 DNA extraction .............................................................................................................................. 9 

5.2 Real-time PCR setup .................................................................................................................. 14 

5.3 Real-Time PCR instrument settings, PCR run and data export.................................................. 16 

6. Troubleshooting.................................................................................................... 19 

6.1 DNA extraction ............................................................................................................................ 19 

6.2 Real-time PCR ............................................................................................................................ 20 

6.3 Warranty ...................................................................................................................................... 21 

6.4 Exclusive terms of sale ............................................................................................................... 21 

6.5 Recommended guidelines for safe use of the products .............................................................. 21 

6.6 Permissible use ........................................................................................................................... 21 

6.7 Notice to user .............................................................................................................................. 21 

 

 

 

 

 

 

 

 
 

 

  

 



PathoProof Complete-16 kit  1 

1. Introduction 

                                                    

 WARNING! Read the Safety Data Sheets (SDSs) and follow the handling instructions. Wear 

appropriate protective eyewear, clothing, and gloves. Safety Data Sheets (SDSs) are available from 

thermofisher.com/support. 

 

Thermo ScientificTM PathoProofTM Complete-16 kit is designed for accurate same-day identification of 

mastitis-causing microorganisms from bovine milk using real-time polymerase chain reaction (PCR). PCR 

technology is used for amplifying DNA in a test tube enabling further analysis of DNA. In the PathoProof 

kits, real-time PCR detects and amplifies the DNA of mastitis-causing microorganisms in a milk sample. 

The microorganism in question is identified based on its unique DNA. The kit includes all the necessary 

reagents for bacterial DNA extraction and PCR. The test has been optimized for use with even the most 

challenging fresh, frozen and preserved milk samples. 

Real-time PCR has become the “gold standard” method for food pathogen testing and quality assurance. 

Based on this advanced technology, PathoProof Complete kits offer several advantages over the 

conventional culture-based methods: 

• Results are obtained substantially faster. 

• Risk of carry-over contamination in the laboratory is minimized because the tests are performed 

in closed reaction vessels that are not opened after the run. 

• Fewer “no growth” results because the test identifies and quantifies DNA, so it accurately detects 

viable, dead and growth-inhibited microorganisms. 

• Applicable for use with preserved milk samples, thus eliminating the need for cooling during 

sample transportation. 

• Can be integrated into milk recording programs using preserved milk. 

The PathoProof Mastitis Complete-16 kit identifies 15 mastitis-causing microorganisms and the β-

lactamase penicillin resistance gene in staphylococci (including Staphylococcus aureus and all major 

coagulase-negative staphylococci). The microorganisms and the β-lactamase gene are detected in four 

separate PCR reactions. The PathoProof Mastitis Complete-16 kit identifies the following targets: 

• Corynebacterium bovis 

• Enterococcus spp. (including E. faecalis and E. faecium) 

• Escherichia coli 

• Klebsiella oxytoca and/or pneumoniae 

• Mycoplasma bovis 

• Mycoplasma spp. 

• Prototheca spp. 

• Serratia marcescens 

• Staphylococcus aureus 

• Staphylococcal β-lactamase gene  

• Staphylococcus spp.  

• Streptococcus agalactiae 

• Streptococcus dysgalactiae 

• Streptococcus uberis 

• Trueperella pyogenes and/or Peptoniphilus indolicus 

• Yeast 



PathoProof Complete-16 kit  2 

2. Kit components and storage conditions 

PF1650 - PathoProof Complete-16 kit is for use with: 

• Applied BiosystemsTM QuantStudio™ 5 Real-Time PCR System, 96-well, 0.1 mL 

• Applied BiosystemsTM  7500 Real-Time PCR Systems  

• Applied BiosystemsTM 7500 Fast Real-Time PCR Systems 

PF1600 - PathoProof Complete-16 kit is for use with the AgilentTM Mx3005PTM Real Time PCR System. 

The PathoProof Complete-16 kit contains all the necessary reagents (except ethanol) for DNA extraction 

and real-time PCR. The kits are stable for six months from the packaging date when stored and handled 

properly. The tables in Section 2.1 - 2.3 list the components included in the kits.  

2.1 KingFisher kit 

The Thermo Scientific™ KingFisher™ kit uses the Thermo Scientific™ KingFisher™ Flex instrument for 

sample preparation. The kit is designed for high throughput laboratories, and/or for laboratories requiring 

a less hands-on time protocol. The KingFisher kit is sufficient for 4 x 96 reactions when at least 40 

samples are analyzed per run.  

The PF1650LKF and PF1600LKF kits contain the following components: 

Component Size Storage conditions 

Buffer AW11 242 ml 

Room Temperature 

Buffer AW22 130 ml 

Tween® 20 Solution 250 ml 

Buffer AE 110 ml 

Buffer RLT1 3x35 ml 

Suspension G2 21 ml 

F-871L Lysis Solution 12 200 ml 

Collection Microtubes (racked) 4x96 

Caps for Collection Microtubes 1x55 

F-872L Lysis Solution 2 4x10 ml 

-20 °C 
F-873L Proteinase K 2x12 ml 

F-882  PathoProof Master mix 16x1.1 ml 

F-929 Universal Amplification Standard 350 µl 

F-1651L3 Primer Mix 1 2x1.1 ml 

-20 °C  

Protect from light 

F-1652L3 Primer Mix 2 2x1.1 ml 

F-1653L3 Primer Mix 3 2x1.1 ml 

F-1654L3 Primer Mix 4 2x1.1 ml 

F-961L4 Primer Mix 1 2x1.1 ml 

F-962L4 Primer Mix 2 2x1.1 ml 

F-963L4 Primer Mix 3 2x1.1 ml 

F-964L4 Primer Mix 4 2x1.1 ml 

1. Contains chaotropic salt. Not compatible with disinfecting agents containing bleach.  
2. Contains sodium azide as a preservative. 
3. Included in PF1650LKF kit for use with Applied Biosystems QuantStudio 5, 7500 and 7500 Fast instruments only. Not 

compatible with Agilent Mx3005P instrument 
4. Included in PF1600LKF for use with Agilent Mx3005P instruments only with the following filter sets: FAMTM, Cy5TM, ROXTM, 

HEXTM/JOETM and ATTOTM. Not compatible with Applied Biosystems QuantStudio 5, 7500 or 7500 Fast instruments.  
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2.2 Manual Large kit 

The Manual Large kits are designed for laboratories performing DNA extraction on large numbers of 

samples in each session. The extraction is performed in 8 well strips and in 96 Column Well Plates. The 

kit is sufficient for 4 x 96 reactions when at least 20 samples are analyzed per run.   

The PF1650L and PF1600L kits contain the following components: 

Component Size Storage conditions 

96 Column Well Plates  4 

Room Temperature 

S-Blocks1 2 

Collection Microtubes (racked) 4x96 

Elution Microtubes CL (racked) 4x96 

Caps for Collection Microtubes 4x55 

Caps for Elution Microtubes 1x50 

Microporous Tape Sheet  25 sheets 

Buffer AL2 2x54 ml 

Buffer AW12   95 ml 

Buffer AW23   66 ml 

Buffer AE 110 ml 

F-871L Lysis Solution 13 200 ml 

F-872L Lysis Solution 2 4x10 ml 

-20°C 
F-873L Proteinase K 2x12 ml 

F-882 Master  Mix 16x1.1 ml 

F-929 Universal Amplification Standard 350 µl 

F-1651L4 Primer Mix 1 2x1.1 ml 

-20°C  

Protect from light 

F-1652L4 Primer Mix 2 2x1.1 ml 

F-1653L4 Primer Mix 3 2x1.1 ml 

F-1654L4 Primer Mix 4 2x1.1 ml 

F-961L5 Primer Mix 1 2x1.1 ml 

F-962L5 Primer Mix 2 2x1.1 ml 

F-963L5 Primer Mix 3 2x1.1 ml 

F-964L5 Primer Mix 4 2x1.1 ml 

 
1. Reusable, wash or autoclave after use. 
2. Contains chaotropic salt. Not compatible with disinfecting agents containing bleach. 
3. Contains sodium azide as a preservative. 
4. Included in PF1650L kit for use with Applied Biosystems QuantStudio 5, 7500 and 7500 Fast instruments only. Not compatible 

with Agilent Mx3005P instrument 
5. Included in PF1600L for use with Agilent Mx3005P instruments only with the following filter sets: FAMTM, Cy5TM, ROXTM, 

HEXTM/JOETM and ATTOTM. Not compatible with Applied Biosystems QuantStudio 5, 7500 or 7500 Fast instruments.  
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2.3 Manual Small kit 

The Manual Small kit is suitable for laboratories handling small numbers of samples in each DNA 

extraction session. The DNA extraction is performed in individual tubes. The kit is sufficient for 50 

reactions when at least 12 samples are analyzed per run.  

The PF1650S and PF1600S kits contain the following components: 

Component Size Storage conditions 

Spin Columns 50 +2-8°C 

Collection Tubes (2 ml) 150 

Room Temperature 

Buffer AL1 12 ml 

Buffer AW11  19 ml 

Buffer AW22  13 ml 

Buffer AE 12 ml 

F-871S Lysis Solution 12 30 ml 

F-872S Lysis Solution 2 4x1.3 ml 

-20°C 
F-873S Proteinase K 1.8  ml 

F-882 Master Mix 2x1.1 ml 

F-929 Universal Amplification Standard 350 µl 

F-1651S3 Primer Mix 1 300 µl 

-20°C                  

Protect from light 

F-1652S3 Primer Mix 2 300 µl 

F-1653S3 Primer Mix 3 300 µl 

F-1654S3 Primer Mix 4 300 µl 

F-961S4 Primer Mix 1 300 µl 

F-962S4 Primer Mix 2 300 µl 

F-963S4 Primer Mix 3 300 µl 

F-964S4 Primer Mix 4 300 µl 

 
1. Contains chaotropic salt. Not compatible with disinfecting agents containing bleach. 
2. Contains sodium azide as a preservative. 
3. Included in PF1650S kits for use with Applied Biosystems QuantStudio 5, 7500 or 7500 Fast instruments only. Not 

compatible with Agilent Mx3005P instrument. 
4. Included in PF1600S kit for use with Agilent Mx3005P instruments only with the following filter sets: FAMTM, Cy5TM, 

ROXTM, HEXTM/JOETM and ATTOTM. Not compatible with Applied Biosystems QuantStudio 5, 7500 or 7500 Fast 
instruments.  
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2.4 Real-time PCR reagent description 

2.4.1 PathoProof Complete-16 kit for Applied Biosystems QuantStudio 5, Applied 
Biosystems 7500 and Applied Biosystems 7500 Fast instrument 

• F-882:  PathoProof Master Mix. PCR master mix in an optimized buffer, containing MgCl2, 
deoxynucleoside triphosphates and hot start DNA polymerase. 

• F-929:  PathoProof Universal Amplification Standard. Control DNA for all targets for use as a positive 
control and for calibration of PathoProof Norden Lab Studio software with the real-time PCR 
instrument and the reagents. 

• F-1651:  PathoProof Complete-16 kit PCR primer mix for reaction 1, including oligonucleotides for 
identification of S. aureus, Enterococcus spp., C. bovis, M. bovis and an Internal Amplification 
Control. 

• F-1652:  PathoProof Complete-16 kit PCR primer mix for reaction 2, including oligonucleotides for 
identification of staphylococcal β-lactamase (penicillin resistance) gene, E. coli, S. dysgalactiae, 
Mycoplasma spp. and an Internal Amplification Control. 

• F-1653:  PathoProof Complete-16 kit PCR primer mix for reaction 3, including oligonucleotides for 
identification of Staphylococcus spp. (including all relevant coagulase-negative staphylococci), S. 
agalactiae, S. uberis, Prototheca spp. and an Internal Amplification Control. 

• F-1654:  PathoProof Complete-16 kit PCR primer mix for reaction 4, including oligonucleotides for 
identification of Klebsiella spp., Serratia marcescens, T. pyogenes, P. indolicus, yeast and an 
Internal Amplification Control. 

2.4.2 PathoProof Complete-16 kit for Agilent Mx3005P instrument 

• F-882:  PathoProof Master Mix. PCR master mix in an optimized buffer, containing MgCl2, 
deoxynucleoside triphosphates and hot start DNA polymerase. 

• F-929:  PathoProof Universal Amplification Standard. Control DNA for all targets for use as a positive 
control and for calibration of PathoProof Norden Lab Studio software with the real-time PCR 
instrument and the reagents. 

• F-961:  PathoProof Complete-16 PCR primer mix for reaction 1, including oligonucleotides for 
identification of S. aureus, Enterococcus spp., C. bovis, M. bovis and an Internal Amplification 
Control. 

• F-962:  PathoProof Complete-16 PCR primer mix for reaction 2, including oligonucleotides for 
identification of staphylococcal β-lactamase (penicillin resistance) gene, E. coli, S. dysgalactiae, 
Mycoplasma spp. and an Internal Amplification Control. 

• F-963:  PathoProof Complete-16 PCR primer mix for reaction 3, including oligonucleotides for 
identification of Staphylococcus spp. (including all relevant coagulase-negative staphylococci), S. 
agalactiae, S. uberis, Prototheca spp. and an Internal Amplification Control. 

• F-964:  PathoProof Complete-16 PCR primer mix for 4, including oligonucleotides for identification of 
Klebsiella spp., Serratia marcescens, T. pyogenes, P. indolicus, yeast and an Internal Amplification 
Control. 
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3. Materials required but not supplied 

The materials required but not supplied with the PathoProof Complete-16 kit are listed below. Please 

contact your local Technical Support team for ordering details. 

• Disposable powder-free gloves 

• Ethanol  (96–100%); do not use denatured ethanol 

• Pipettes 

• Sterile pipette tips with filter 

• PCR plates compatible with the real-time PCR instrument 

o For QuantStudio 5 and Applied Biosystems 7500 Fast system:  order catalogue number 
4346907 MicroAmp™ Fast Optical 96-Well Reaction Plate 

o For Applied Biosystems 7500 system:  order catalogue number AB-1400 - 96-well PCR 
Plate 

o For Agilent Mx3005P systems: order catalogue number AB-0600 96 -well PCR Plate 

• Optically clear PCR vessel caps: order catalogue number AB-0866 - Optically clear flat 8 Cap Strips  

• Vortex mixer 

• Microcentrifuge compatible with the spin tubes  

• Either 1.5 ml or 2 ml tubes for sample preparation 

• Strip tubes for sample preservation after DNA extraction (optional) 

• Real-time PCR instrument compatible with PathoProof kits:  

o Applied Biosystems QuantStudio 5 Real-Time PCR System, 96-well, 0.1 mL 

o Applied Biosystems 7500 and 7500 Fast Real-Time PCR System with the following dyes 
calibrated: FAM, CY5, Texas Red, VIC and TAMRA 

o Agilent Mx3005P qPCR System with filter sets for: FAM, CY5, ROX, HEX/JOE and ATTO.  

Depending on the extraction platform used, materials or instruments not supplied with the PathoProof 

Complete-16 kit are listed below. Please contact your local Technical Support team for ordering details. 

 

3.1 KingFisher kits  

• KingFisher Flex instrument 

• Plate centrifuge capable of 1500 xg 

• 96 DeepWell Plate 

• KingFisherFlex 96 Tip Comb  

• Adhesive Plate Seal for storing eluted samples: order catalogue number AB-0558 Adhesive Sealing 
Sheets  

 

3.2 Manual Large kits 

• Decapping tool 

• Thermo ScientificTM HeraeusTM Multifuge X3 plate centrifuge 

• Two dry bath incubators capable of +37°C and +55°C 

• Two dry bath 96 blocks for Collection Microtubes  
 

3.3 Manual Small kits 

• Microcentrifuge for 1.5 or 2 ml tubes that is capable of 20 000 xg 

• Two dry bath incubators for +37°C and +55°C  

• Two or more dry bath blocks for 1.5 ml or 2 ml tubes 
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4. General guidelines 

The following general guidelines should be followed throughout the PathoProof Complete-16 kit protocol: 

• Use protective gloves 

• Thaw all frozen reagents thoroughly prior to use 

• Mix all solutions well before use 

• Spin down reagents after mixing 

4.1 Avoiding carryover contamination 

Due to their high sensitivity, real-time PCR kits are susceptible to carryover contamination of DNA. The 

contaminating DNA is typically an amplification product from a real-time PCR run, but can also originate 

from samples containing high quantities of target bacterial DNA. 

The PathoProof Complete-16 kit does not require opening of the real-time PCR vessels once the real-

time PCR program has been started. While this kit design significantly reduces the risk of cross-

contamination, the following general guidelines should be followed, in addition to other precautions 

mentioned in this instruction manual, in order to minimize such risks: 

• Designate physically separated working areas for:  

o DNA extraction (handling of milk samples or other samples containing bacteria) 

o PCR preparation 

• Use different laboratory equipment (disposable gloves, pipettes, pipette tip boxes, vortexes, 
centrifuges, laboratory coats etc.) in each working area. 

• Change gloves frequently and always before leaving an area. 

• Use aerosol-resistant pipette tips. 

• Use new and/or sterilized plastic ware. 

• After starting a real-time PCR run, do not open the real-time PCR vessels under any circumstances. 

• Always dispose the real-time PCR vessels into a dedicated, closed trash container and make sure 
that the vessels do not open accidentally. 
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5. PathoProof Assay Workflow  

This section contains instructions for performing DNA extraction, real-time PCR setup and PCR run. The 

instructions for performing results analysis with Thermo Scientific™ PathoProof™ Norden Lab Studio™ 

software are given in the PathoProof Norden Lab Studio software manual. An overview of the laboratory 

workflow is presented in Figure 1 below. 

 

 
 
 
 
 
 
 
 
 
 
                                                                        
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

                                                

 

 

 

Figure 1. Schematic illustration of the PathoProof assay workflow in three easy steps. 

 

1. DNA is extracted from fresh, frozen or preserved bovine milk samples. 
2. Extracted DNA is used to set up the PCR reactions in a 96-well PCR plate. Four separate PCR 

reactions are run for each sample. 
3. The obtained data is interpreted, reported and data-based with Norden Lab Mastitis Studio 

software. 
 

PathoProof Norden Lab Studio software is an application designed for interpreting, reporting and storing 

the results obtained using PathoProof kits. This software facilitates data analysis and is highly 

recommended as an integral part of the procedure for the PathoProof Complete-16 kit. 

1 

2 

3 

+1 hr 30 min 

+1 min 

Sample 

preparation 

PCR 

Result 

analysis 

1 hr 30 min. 
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When using PathoProof kit for the first time, it is necessary to calibrate PathoProof Norden Lab 

Studio software. Calibration may also be required when changing real-time PCR plastics or when 

the real-time PCR instrument has undergone maintenance. The calibration runs and experiment 

runs must be performed using the same real-time PCR instrument, the same type of 

vessels/plastics, and same optically clear caps for sealing the PCR plate.  

Dye calibration is also required for Applied Biosystems™ 7500 instruments that have not 

previously been calibrated for dyes FAM, CY5, TAMRA, VIC and TEXAS RED.  

 

5.1 DNA extraction  

Before starting: 

• Buffers AW1 and AW2 are supplied as concentrates. Before using them for the first time, add the 
amount of ethanol (96–100%) indicated on the bottles. 

• Equilibrate Buffer AE to room temperature. 

KingFisher kits only:   

• Buffer RLT is provided in 35 ml bottles. To prepare the mixture for the extraction, add 35 ml ethanol 
(96-100%) and 7 ml Suspension G to the Buffer RLT bottle. Vortex the Suspension G for 3 min 
before using it for the first time and 1 min before subsequent use. The mixture is stable for one year.  

• The 96 Tip Combs are supplied as packages of 2. If opening a new package, store the other 96 Tip 
Comb within an unused 96 DeepWell Plate. 

• Wash and Elution plates can be filled, sealed with Cap Mats or Adhesive Plate Seals and preserved at 
room temperature for one month. If using Adhesive Plate Seals ensure that the rims of the plates are 
dry and clean before sealing. Ensure that no liquid has evaporated from the wells (especially from the 
corner wells) before using the prefilled plates for extraction. Small amount of evaporation (10-25%) 
does not affect the efficiency of the extraction. Prefilled plates should not be shaken or heated. 

Manual Large and Small kits only: 

• Set two incubators with the proper block inserts at +37°C and +55°C. 

5.1.1 DNA extraction for KingFisher kits 

1. Prepare eight 96 DeepWell Plates according to the table below.  

 
Plate name 

 
Reagent 

 
Volume per well 

Tip Comb Plate Place Tip Comb plate into 96 DW Plate - 

Sample Proteinase K F-873L 40 µl 

Wash 1 Buffer AW1 800  µl 

Wash 2 Buffer AW1 500  µl 

Wash 3 Buffer AW2 500  µl 

Wash 4 Buffer AW2 500  µl 

Wash 5 Tween® 20 Solution 600  µl 

Elution Buffer AE 150  µl 
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• Add reagents only to wells allocated for each sample and the extraction negative control. Example 
sample layout for a total of 60 samples and negative control is presented in Figure 2.  

• Mark the seven 96 DeepWell Plates accordingly from Sample, Wash 1 to Wash 5 and Elution for 
later identification.  

      Tip comb plate                 Sample plate                      Wash 1 

 

               Wash 2             Wash 3                Wash 4 

 

               Wash 5            Elution 

 

Figure 2. Filling the Thermo Scientific™ KingFisher™ 96 DeepWell plates for KingFisher kit. This 

setup is an example for 60 samples and 1 extraction negative control. 

• After filling the plates, put these plates aside for the sample preparation process (steps 2 – 5). The 
prefilled plates can be stacked (96 Tip Comb plate at the top) to avoid contamination of the 
extraction reagents. 

2. Depending on the sample type, prepare samples for centrifugation using the instructions below: 

• For individual quarter milk samples: Add 400 μl of Lysis Solution 1 and 400 μl milk sample into 
racked Collection Microtubes. Avoid pipetting milk clots into the reaction vessels.  

• For DHI samples: Prepare a fresh mix containing the following volumes per sample: 5 µl 
Proteinase K and 400 µl Lysis Solution 1. If using a multichannel pipette, add in an extra 1-2 
reactions to ensure sufficient volume. Add 400 µl of the Lysis Solution 1/Proteinase K mix and 
600 µl milk sample into racked Collection Microtubes. 

 In addition to the milk samples, include at least one negative control (reagents only) in each DNA 

extraction run. Seal the tubes using the caps provided for Collection Microtubes. 

3. Mix well by vortexing or shaking and centrifuge for 3 min at 3000 rpm. 

4. The presence of fat on top of the supernatant following centrifugation is normal. Remove the 

supernatant and fat layer on top of supernatant using a pipette without disturbing or removing the 
pellet. After liquid removal, approximately 50-100 µl of residual fat/liquid on top of the pellet is 

normal and does not need to be removed. 
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5. Resuspend the pellet carefully in 100 μl Lysis Solution 2 by pipetting up and down and transfer the 

sample into a well of the sample plate using a pipette.  

6. Switch on the KingFisher Flex instrument at the power switch. If using the KingFisher Flex 
instrument through a computer, open the Thermo Scientific™ BindItTM software from the computer 

connected to the KingFisher Flex instrument. 

7. Select the ‘’PathoProof’’ protocol from the DNA/RNA menu under factory protocols. Press ‘’Start’’ to 

start the run. 

8. Open the cover of the instrument and load the plates into the instrument as indicated on the 

KingFisher Flex display. After each plate press ‘’Start’’ and after the worktable has rotated load the 
next plate. After loading the last plate close the protective cover and press ‘’Start’’ to initiate the run. 

 

After completion of the sample incubation steps, the extraction protocol pauses for 2 minutes and 

offers the option to remove the sample plate. Remove the sample plate immediately when the 

instrument pauses or wait for the full 2 minutes before removing the plate. At the end of the next 

step, take caution to only add the plate back when the instrument asks for insertion of the sample 

plate. This will avoid spillages and potential injury from the moving instrument turntable. 

 

9. Take the sample block from the KingFisher instrument, shake the mixture containing Buffer RLT, 
ethanol and Suspension G thoroughly for 10 s and add 440 μl to each sample in the sample plate. 

Load the plate back into the instrument when the instrument asks to do so. Press ‘’Start’’ to continue 

the run.  

 

If dispensing the mixture into wells with a multichannel dispenser, make sure tips do not touch 

the well walls or the liquid in the wells.  

 

10. After the samples have been processed remove the plates as instructed by the KingFisher Flex 

display.  

• If the eluted samples are going to be stored, seal the wells of the elution plate with a Cap Mat or 
an Adhesive Plate Seal.  

• The presence of a small amount of beads in the eluted DNA is normal and does not affect the 
PCR step. 

Proceed to Section 5.2 for real-time PCR setup. 

 

5.1.2 DNA extraction for Manual Large kit 

Centrifugation of 96 Column Well Plates is performed on the Heraeus Multifuge X3 plate centrifuge. 

1. Prepare a fresh mix containing the following volumes per sample: 7 µl Proteinase K and 350 µl Lysis 

Solution 1. If using a multichannel pipette, add in an extra 1-2 reactions to ensure sufficient volume. 

2. Vortex or shake the milk samples thoroughly. Add 350 µl of Lysis Solution 1/Proteinase K mix and 350 
µl milk sample into racked Collection Microtubes. Avoid pipetting milk clots to the reaction vessels. In 

addition to the milk samples, include at least one negative control (reagents only) in each DNA 

extraction. Seal the tubes using the caps provided for Collection Microtubes. 

3. Vortex briefly and incubate at 55°C for 5 min.  
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4. Centrifuge for 5 min at 5000 rpm. 

5. The presence of fat on top of the supernatant following centrifugation is normal. Remove the 

supernatant and fat using a pipette without disturbing or removing the pellet. Residual fat/liquid on top 
of the pellet is normal and does not need to be removed. 

6. Resuspend the pellet in 100 µl Lysis Solution 2 by pipetting up and down. Seal the tubes using new 

caps for Collection Microtubes. 

7. Incubate at 37°C for 10 min. 

8. Prepare a fresh mix containing the following volumes for each sample: 20 µl Proteinase K and 200 µl 

Buffer AL. If using a multichannel pipette, add in an extra 1-2 reactions to ensure sufficient volume. 
Add 220 µl of the mix to each sample, taking care not to wet the rims of the Collection Microtubes. 

Seal the tubes using new caps for Collection Microtubes. 

9. Mix thoroughly by shaking vigorously for 15 sec. For efficient lysis, it is essential that the samples and 

Buffer AL are mixed immediately and thoroughly to yield a homogeneous solution. Hold the racked 

Collection Microtubes with both hands and shake up and down vigorously. 

10. Incubate at 55°C for 10 min. Centrifuge briefly at 3000 rpm to remove drops from inside the caps. Stop 

the centrifuge as soon as it reaches 3000 rpm. 

11. Add 200 µl ethanol (96–100%) to each tube. Seal the tubes using new caps for Collection Microtubes. 

Shake vigorously for 5 sec. Centrifuge briefly at 3000 rpm to remove drops from inside the caps. Stop 

the centrifuge as soon as it reaches 3000 rpm. 

12. Place the 96 Column Well Plate on top of an S-Block. Seal unused wells with Microporous Tape Sheet 
and mark the column numbers for later identification in the next extraction.  

13. Remove the possible viscous clots from the mixture prepared in step 11 using a pipette. Carefully 

apply the supernatant to the 96 Column Well Plate.  Take care not to wet the rims of the wells to avoid 

aerosol formation during centrifugation. 

14. Seal the 96 Column Well Plate with Microporous Tape Sheet. Load the S-Block and 96 Column Well 
Plate onto the carrier. Place the carrier in the rotor bucket and centrifuge at 6000 rpm for 4 min. 

15. Place the 96 Column Well Plate on top of an empty S-Block. Remove the tape. Carefully add 500 µl 

Buffer AW1 to each well. Seal the 96 Column Well Plate with a new Microporous Tape Sheet. 

Centrifuge at 6000 rpm for 4 min. 

16. Place the 96 Column Well Plate on top of an empty S-Block. Remove the tape. Carefully add 500 µl 

Buffer AW2 to each well. To ensure evaporation of residual ethanol in the following centrifugation step, 
do not seal the plate. Centrifuge at 6000 rpm for 15 min.  

17. Place the 96 Column Well Plate on top of a rack of Elution Microtubes. To elute the DNA, add 100 µl 

Buffer AE to each well. Seal the 96 Column Well Plate with a new Microporous Tape Sheet, and 

incubate for 1 min at room temperature. Centrifuge at 6000 rpm for 4 min.  

18. Inspect the tubes and samples. If samples can be seen to have a concave meniscus or show an 
uneven elution volume, dilute the eluted samples using AE buffer or distilled water. 

 

1:2 1:2 1:2 1:2 1:2 
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19. Seal the wells using the caps for Elution Microtubes. 

Proceed to Section 5.2 for real-time PCR setup. 

 

5.1.3 DNA extraction for Manual Small kits  

Centrifugation of Spin Columns is performed using a Microcentrifuge capable of 20 000 xg. 

1. Prepare a fresh mix containing the following volumes per sample: 7 µl Proteinase K and 350 µl 

Lysis Solution 1. Add in an extra 1 - 2 reactions to ensure sufficient volume. 

2. Vortex or shake the milk samples thoroughly. Add 350 µl of Lysis Solution 1/Proteinase K mix and 
350 µl milk to each reaction vessel. Avoid pipetting milk clots into the reaction vessels. In addition to 

the milk samples, include at least one negative control (reagents only) in each DNA extraction. 

3. Vortex briefly and incubate at 55°C for 5 min. 

4. Centrifuge for 5 min at 5000 xg. 

5. The presence of fat on top of the supernatant following centrifugation is normal. Remove the 

supernatant and fat using a pipette without disturbing or removing the pellet. Residual fat/liquid on 
top of the pellet is normal and does not need to be removed. 

6. Resuspend the pellet in 100 µl Lysis Solution 2 by pipetting up and down. 

7. Incubate at 37°C for 10 min. 

8. Prepare a fresh mix containing the following volumes per sample; 20 µl Proteinase K and 200 µl 

Buffer AL. Add in an extra 1 - 2 reactions to ensure sufficient volume.  Add 220 µl of the mix to each 
reaction vessel. Mix by vortexing for 5 - 10 sec. 

9. Incubate at 55°C for 10 min. Briefly centrifuge the reaction vessels to remove drops from inside the 

caps. 

10. Add 200 µl ethanol (96–100%) to each sample and mix by pulse-vortexing for 15 sec. It is essential 

that the sample, the Buffer AL and the ethanol are mixed thoroughly to yield a homogeneous 

solution. Do not use alcohols other than ethanol, as this may result in reduced DNA yields. After 
mixing, briefly centrifuge the reaction vessels to remove drops from inside the caps. 

11. Remove the possible viscous clots from the mixture using a pipette. Then, carefully apply the 

supernatant to the Spin Column (placed inside a 2 ml collection tube) without wetting the rim. Close 

each Spin Column to avoid aerosol formation during centrifugation. Centrifuge at 20,000 xg 

(~14,000 rpm) for 1 min. Place the Spin Column in a clean 2 ml Collection Tube (provided), and 
discard the tube containing the filtrate. 

12. Carefully open the Spin Column and add 500 µl Buffer AW1 without wetting the rim. Close the cap 

and centrifuge at 20,000 xg (~14,000 rpm) for 1 min. Place the Spin Column in a clean 2 ml 

Collection Tube (provided), and discard the Collection Tube containing the filtrate. 

13. Carefully open the Spin Column and add 500 µl Buffer AW2 without wetting the rim. Close the cap 

and centrifuge at 20,000 x g (~14,000 rpm) for 3 min. 

14. Place the Spin Column in a clean 1.5 ml microcentrifuge tube (not provided), and discard the 

Collection Tube containing the filtrate. Carefully open the Spin Column and add 100 µl Buffer AE. 

Incubate at room temperature for 1 min, and then centrifuge at 20,000 x g (~14,000 rpm) for 3 min 

to elute the DNA. Discard the Spin Column. 

Proceed to Section 5.2 for real-time PCR setup. 
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5.2 Real-time PCR setup 

Throughout the procedure, follow the general guidelines detailed in Section 4. 

Important notes before starting: 

• Use at least one negative (no template) PCR control for each of the four PCR solutions in each real-
time PCR run. 

• If all the samples are expected to be negative for the targets, it is advisable to include the PathoProof 
Universal Amplification Standard and/or a positive DNA extraction control (such as a milk sample 
previously tested positive with PathoProof Complete-16 kit) in each real-time PCR run. 

• The experiment runs must be performed using the same real-time PCR instrument, the same type of 
vessels and the same sealing method (optically clear caps) that was used when calibrating the 
PathoProof software (see PathoProof Norden Lab Studio software manual). 

• The purified DNA can be stored at +5°C for a few days and for longer periods at -20°C. 

1. Vortex briefly the thawed PathoProof Master Mix and PathoProof Primer Mixes 1- 4 and spin down. 

2. Prepare four separate PCR solutions by combining PathoProof Master Mix and PathoProof Primer 
Mixes 1, 2, 3 and 4 in four separate microcentrifuge tubes. Use the formula on the next page to 
calculate the volumes required. The formula provides excess volume to compensate for volume loss 
due to reagent pipetting steps. 
 

PCR solution Reagent Volume  

PCR solution 1 
PathoProof Master Mix N x 11 µl 

PathoProof Primer Mix 1 N x 5.5 µl 

PCR solution 2 
PathoProof Master Mix N x 11 µl 

PathoProof Primer Mix 2 N x 5.5 µl 

PCR solution 3 
PathoProof Master Mix N x 11 µl 

PathoProof Primer Mix 3 N x 5.5 µl 

PCR solution 4 
PathoProof Master Mix N x 11 µl 

PathoProof Primer Mix 4 N x 5.5 µl 

N = Number of samples including: 

•       Negative PCR control (necessary in every run) 

•       PathoProof Universal Amplification Standard (positive control, optional) 

•       Negative DNA extraction control (recommended) 

•       Positive DNA extraction control (optional) 

•       DNA from extracted milk samples 

 

3. Vortex the PCR solutions briefly and spin down. 

4. Add 15 µl of the PCR solutions 1, 2, 3 and 4 into the four wells allocated for each sample. Figure 3 

shows an example for allocating PCR solutions 1 - 4 for five samples and one negative control. 
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Figure 3. Example setup for pipetting PCR solutions in Complete-16 kit. 

 

Always add PCR solution 1 to plate columns 1, 5 and 9,  PCR Solution 2 to columns 2, 6 and 10, 

PCR solution 3 to columns 3, 7 and 11 and PCR solution 4 to columns 4, 8 and 12. This order must 

be maintained for correct data analysis when using the PathoProof Norden Lab Studio software.  

 

5. Add 5 µl of the eluate from the DNA extraction protocol (Section 5.1) into the four wells allocated for 
each sample. Figure 4 shows an example for pipeting 5 samples and negative control into 

previously prepared PCR solution plate. 

  

 

Figure 4. Example setup for 5 samples and one Negative PCR control. Negative PCR control reactions 

are always allocated to the last available wells. 
 

a. If the PathoProof Universal Amplification Standard is included in the test setup, add 5μl of 

the standard into four consecutive wells. 

b. In the wells allocated for negative (no template) controls, add 5μl of sterile water or Elution 

Buffer (AE).  

6. Close the 96-well PCR plate with optically clear caps and centrifuge using a suitable plate 

centrifuge (3000 rpm, 5 sec).  

PCR solution 1 

PCR solution 2 

PCR solution 3 

PCR solution 4 
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Note: It is critically important to use the optically clear caps. Do not use adhesive seal or heat seal to 

close the PCR plates as performance of the assay will be adversely affected.  

Proceed to instrument-specific instructions in Section 5.3. 

5.3 Real-Time PCR instrument settings, PCR run and data export 

 

Instrument specific template files needed for PathoProof calibration and sample runs will be 

installed into the PathoProof Norden Lab Studio directory and a link to these files will be created 

onto the desktop during the software installation process. PathoProof software (and the 

instrument specific template files) is available to download at www.nordenlogic.com.  

 

5.3.1 Applied Biosystems QuantStudio 5 Real-Time PCR System  

1. Open template file 

Open PathoProof template file for QuantStudio 5 instrument. Wait for instrument initialization. 

2. Load the plate 

Open tray by selecting tray icon from instrument touch screen in the instrument and load the plate. Close 

the tray by selecting the tray icon again. 

3. Name samples  

Name the samples as needed (samples may be named after the run) by selecting Plate-section and then 

selecting Advanced Setup. PathoProof template files have sample place holder names (similar to Figure 

4) that can be renamed. 

Select wells that are not going to be used and then select “Clear” from right click options. 

Optional: Sample names can be imported into run template file by selecting File → Import Plate Setup 

and then searching Sample layout file generated with Sample layout tool. Assay specific Sample layout 

tools have been saved to each assay template file folder. 

4. Start the run 

To start the sample run, select START RUN -button in the Run tab, select the instrument from drop down 

menu and input run file name to save the file. Run is initialized once save-button has been selected.  

5. Export raw data for the PathoProof software 

After the real-time PCR run, select Export. 

1. Update the export file name from File Name -field if needed. 
2. Ensure that the file type is QuantStudio and file extension is .xls 
3. Next to Location, search preferred file saving location.  
4. Make sure that the Sample Setup and Amplification Data -boxes have been selected under 

Content.  
5. Make sure to select Unify the above content into one file under Options. 
6. Generate export file from the run by selecting Export.  

Follow the instructions in your PathoProof Norden Lab Studio software manual in order to import the data 

into PathoProof Norden Lab Studio software. 
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5.3.2 Applied Biosystems 7500 Real-Time PCR System  

PathoProof assays are only compatible with instrument software versions 2.0.6 and above. 

Before using the PathoProof assay, the Applied Biosystems 7500 or 7500 Fast Real-Time PCR System 

needs to be calibrated for the following dyes: 

• FAM 
• VIC 
• TAMRA 
• CY5 
• TEXAS RED 

If the Applied Biosystems 7500 or 7500 Fast Real-Time PCR System does not have these dyes 

calibrated, please contact your local Technical  Support team to order Spectral Calibration Kits I and II for 

ABI7500 systems. 

1. Open template file 

Open PathoProof template file for ABI7500 instrument. Wait for instrument initialization. 

2. Load the plate 

Push the tray door to open it and load the plate. Close the tray door. 

3. Name samples  

Name the samples as needed (samples may be named after the run) by selecting Setup -section on left 

and then Plate Setup. PathoProof template files have sample place holder names (similar to Figure 4) in 

section Define Samples that can be renamed. Select wells that are not going to be used and then select 

“Clear” from right click options. 

Optional: Sample names can be imported into run template file by selecting File → Import Plate Setup 

and then searching Sample layout file generated with Sample layout tool. Assay specific Sample layout 

tools have been saved to each assay template file folder. 

4. Save the run 

Save the file in a separate location and with different file name for later identification and to ensure, that 

the default PathoProof template file is not over written. 

5. Start the run 

Start the run by clicking the Start run -button in the Setup Screen. 

6. Export raw data for the PathoProof software 

After the real-time PCR run, choose Analysis option from the left side of the screen. 

Select Export. 

1. Make sure that the Sample Setup and Amplification Data -boxes have been selected next to 1. 
Select data to export. 

2. Make sure that One file is selected next to 2. Select one file or separate files 
3. Update the Export File Name if needed and ensure that the file extension is .xls from section 3. 

Enter export file properties 
4. Select Open file(s) when export is complete and Save current settings as default -check 

boxes 
5. Generate export file from the run by selecting Start Export and Follow the instructions in your 

PathoProof Norden Lab Studio Software manual in order to import the data into PathoProof 
Norden Lab Studio software. 
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5.3.3 Agilent Mx3005P qPCR System 

PathoProof Complete-16 kit is only compatible with instrument that has the following filter sets: 

• FAM 
• CY5 
• ROX 
• HEX/JOE  
• ATTO 

If your Agilent instrument does not have these filter sets, please contact Thermo Fisher Scientific 

technical support: microbiology.techsupport.uk@thermofisher.com. 

Before the first run and after instrument maintenance, verify that the Filter Gain Settings are as follows 

(from the Instrument selection -> Filter Set Gain Settings):1x for CY5, 4x for ATTO, 1x for ROX, 2x for 

HEX/JOE and 4x for FAM  

1. Open template file and switch lamp on 

Open PathoProof template file for Mx3005P instrument. Wait for instrument initialization. Switch the 

instrument’s lamp on by clicking the lamp icon.  

2. Name samples  

Name the samples as needed (samples may be named after the run if preferred).  

3. Clear empty wells 

Select the empty wells and click “Clear Selected Wells” in the panel at the right. 

4. Save the run 

Save the file in a separate location and with different file name for easy identification and to ensure, that 

the PathoProof template file is not over written.  

5. Load the plate and Start the run 

Open instrument door and pull from the handle of heat lid tray. Insert the PCR plate under the heat lid and 

push the heat lid back to it’s original location. Close the instrument door. 

Start the run by clicking the Start run -button in the Thermal Profile Setup. 

6. Export raw data for the PathoProof software 

Generate export file from the run by: 

• Click the Analysis button, then the Results tab. 

• Select File menu from the top left. 

• Select Export Chart Data → Export Chart Data to Text file → Format 1 -- Vertically Grouped by 
Plot... 

Now follow the instructions in your PathoProof Norden Lab Studio software manual in order to import the 

data into PathoProof Norden Lab Studio software. 
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6. Troubleshooting 

Possible problems in real-time PCR are presented first, followed by problems in DNA extraction. 

6.1 DNA extraction 
 

This table presents explanations for the following problems: little or no DNA was obtained from the milk 

samples, or the extracted DNA is contaminated with inhibitory substances. 

Possible explanation(s) Recommended action 

Inefficient lysis due to reduced Proteinase K 

activity. 

Be sure to store the Proteinase K solution at -20 °C or, when in use, on ice. 

Always be sure to prepare fresh mixes of Proteinase K with Lysis Solution 1 

and with Buffer AL. Repeat the DNA purification procedure with a new sample. 

Inefficient cell lysis due to insufficient mixing of 

the sample with Buffer AL. 

Repeat the DNA purification procedure with a new sample. Be sure to mix the 

sample and Buffer AL immediately and thoroughly by pulse-vortexing. 

No ethanol or incorrect kind of ethanol added to 

the lysate before loading onto the column or the 

96 Column Well Plates. 

Repeat the purification procedure with a new sample. Use 96–100% ethanol. 

Do not use denatured ethanol, isopropanol or lower percentage ethanol. 

Buffer AW1 or AW2 prepared incorrectly. 

Repeat the purification procedure with a new sample. Ensure that the Buffer 

AW1 and AW2 concentrates were diluted with the correct volumes of 96–100% 

ethanol as indicated on the bottles. Do not use denatured alcohol, isopropanol 

or lower percentage ethanol. 

Buffers AW1 and AW2 used in the wrong order. 
Ensure that Buffers AW1 and AW2 are used in the correct order in the 

protocol. Repeat the purification procedure with a new sample. 

Residual Buffer AW2 in the eluate. 

Ensure that the Spin Column or the 96 Column Well Plate does not come into 

contact with the filtrate prior to elution. 

Before DNA elution, ensure that the 96 Column Well Plate is centrifuged 

without the Microporous Tape Sheet in order to allow ethanol to evaporate 

from the sample. 

Spin Column or 96 Column Well Plate not 

incubated at room temperature (15–25 °C) for 1 

min before elution. 

After the addition of Buffer AE, the Spin Column or the 96 Column Well Plate 

should be incubated at room temperature for at least 1 min. 

DNA not eluted efficiently. 

To increase elution efficiency, pipet Buffer AE onto the center of the spin 

column or the 96 Column Well Plate and incubate for 5 min at room 

temperature before centrifugation. 
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6.2 Real-time PCR 

This table presents explanations for the following problems: IAC Ct values are not within acceptable 

range, positive target amplification signal in negative control, acceptable IAC Ct in all samples but no 

positive results, false positive signal read in most of the samples 

Problem Possible explanation(s) Recommended action 

The Ct values of the Internal 

Amplification Controls are not within 

the acceptable range in samples* 

and in negative controls**. 

Missing reagents in the PCR setup. Repeat the real-time PCR 

Incorrect volume of master mix and/or 

primer mix in wells. 

Make sure that the correct amounts of primer mix 

and master mix are added into the correct wells. 

Unacceptable IAC amplification 

signals for all samples* but 

acceptable IAC signals for the 

Negative controls. 

PCR inhibitors originating from the DNA 

extraction are present in the test samples. 
Refer to Chapter 5.1 "DNA extraction". 

Unacceptable lAC amplification 

signals for all parallel reactions of 

one sample* but acceptable IAC 

signals in the other samples and the 

Negative controls. 

Missing reagents in the wells of the sample 

or incorrect volume of reagent. 
Repeat the real-time PCR for the sample. 

The PCR inhibitor concentration of the 

sample is too high. 

Dilute the extracted DNA sample (use 1:5 and 1:10 

dilutions for example) and repeat the real-time 

PCR. See Chapter 5.1 "DNA extraction”. 

Unacceptable IAC amplification 

signals for one reaction of one 

sample* but acceptable IAC 

amplification signals for the other 

parallel reactions of the sample, the 

other samples and the Negative 

controls. 

Missing reagents in the well concerned or 

incorrect volume of reagent. 

Repeat all parallel real-time PCR reactions of the 

sample. 

Bacterial DNA is present in a high quantity 

(+++) in the sample (confirm the presence 

of bacterial DNA by inspecting the 

amplification curves). 

No action required. 

PCR inhibitors originating from the DNA 

extraction are present in the test samples 

at such high concentration that they inhibit 

the amplification of less robust IAC (the 

higher the inhibitor concentration, the more 

IACs will fail starting from primer  mix 1) 

Dilute the extracted DNA sample (use 1:5 and 1:10 

dilutions for example) and repeat the real-time PCR 

for all parallel reactions of that sample. See 

Chapter 5.1 “DNA extraction”. 

Unacceptable IAC amplification 

signals** for one reaction of Negative 

control or all parallel reactions of 

Negative control but acceptable IAC 

amplification signals in sample wells. 

Missing reagents in the wells of the 

negative control. 
No action required because the IACs in the 

samples are acceptable Incorrect volume of master mix and/or 

primer mix in wells. 

Positive bacterial target amplification 

signals in wells for Negative control. 

A carryover contamination may have 

occurred in the laboratory. 

Take precautions detailed in Section 4.1 to 

minimize contaminations. 

Acceptable IAC amplification signals 

in all wells, but all targets negative. 

Failed DNA extraction. 
Refer to Chapter 5.1 “DNA extraction”. Include 

PathoProof Amplification Standard and/or a 

positive DNA extraction control, such as a milk 

sample previously tested positive with PathoProof 

kit. There were no bacteria present in the 

samples. 

Amplification signal is not smooth 

and/or is linear  

Adhesive seal or heat seal was used in 

closing PCR plate. Heating protocol used in 

PathoProof will stretch the seal on well, 

which may result in abnormal signal reads. 

Refer to section 4.3 in PathoProof Norden Lab 

Studio IFU to interpret and exclude false positive 

signal reads from sample. To avoid false positive 

signal reads, use optically clear caps  

 

*   If the Ct values of the Internal Amplification Controls are not within the acceptable range, PathoProof Norden Lab Studio 
displays a warning icon ( ) beside the sample name in the run viewer and in the upper left corner of the sample viewer. 

Additionally, the word “Failed” appears after the IAC Ct values in the sample viewer. 
** If the Ct values of the Internal Amplification Controls are not within the acceptable range in the negative controls, PathoProof 

Norden Lab Studio displays a warning icon (  ) beside the run name in the database view and in the upper left corner  of the 
negative control viewer. Additionally, the word “Failed” appears after the IAC Ct values in the negative control viewer 
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6.3 Warranty 

Thermo Fisher Scientific warrants that its products wilI meet the specifications stated on the technical 

data Section of the data sheets, and Thermo Fisher Scientific agrees to replace the products free of 

charge if the products do not conform to the specifications. Notice for replacement must be given within 

60 days of receipt. In consideration of the above commitments by Thermo Fisher Scientific, the buyer 

agrees to and accepts the following conditions: 

 

1. That this warranty is in lieu of all other warranties, express or implied; 

2. That ALL WARRANTIES OF MERCHANTABILITY OR OF FITNESS FOR A PARTICULAR PURPOSE 

ARE HEREBY EXCLUDED AND WAIVED; 

3. That the buyer’s sole remedy shall be to obtain replacement of the product free of charge from Thermo 

Fisher Scientific; and 

4. That this remedy is in lieu of all other remedies or claims for damages, consequential or otherwise, 

which the buyer may have against Thermo Fisher Scientific. 

6.4 Exclusive terms of sale 

Thermo Fisher Scientific does not agree to and is not bound by any other terms or conditions, unless 

those terms and conditions have been expressly agreed to in writing by a duly authorized officer of 

Thermo Fisher Scientific. Prices are subject to change without notice. 

6.5 Recommended guidelines for safe use of the products 

Thermo Fisher Scientific recommends that the buyer and other persons using the products follow the 

Guidelines for Research involving Recombinant DNA Molecules (NIH guidelines) Federal Register, July 5, 

1994 (59 FR 34496) and any amendments thereto. Thermo Fisher Scientific disclaims any and all 

responsibility for any injury or damage which may be caused by the failure of the buyer or any other 

person to follow said guidelines. 

6.6 Permissible use 

This product is intended to be used for the purpose of detection and/or analysis of microorganisms in milk 

for quality assurance and quality control purposes (Food Testing Applications), as well as for 

identification, enumeration, or count of microorganisms in raw material sample, process control sample, 

or finished product sample of an industrial process for the purpose of detecting the presence, absence or 

amount either of a contaminant or of an intended component.  

6.7 Notice to user 

The information presented here is accurate and reliable to the best of our knowledge and belief, but is not 

guaranteed to be so. Nothing herein is to be construed as recommending any practice or any product in 

violation of any patent or in violation of any law or regulation. It is the user’s responsibility to determine for 

himself or herself the suitability of any material and/or procedure for a specific purpose and to adopt such 

safety precautions as may be necessary.
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